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Dare to Ask? Online  
a user guide for Oxfordshire 

Introduction
The aim of Dare to Ask? Online is to simplify the process of gathering feedback for 
the development of effective careers education and involve students in evaluating 
their career learning. This gives students a voice so that they can make a positive 
contribution to the evaluation of the careers education programme.  

Each learning outcome used in the evaluation questionnaires was derived from the 
learning outcomes in the national framework for careers education and guidance 
(DfES 2003).

More detailed information about the questionnaires and support in carrying out an 
evaluation and interpreting results are available in the Dare to Ask? paper-based 
resource. If you do not have a copy, please contact us. 

How does the online version differ from the 
paper-based resource? 
The questionnaires are identical to those in the paper-based version of Dare to Ask?
The advantage of the online version is that all calculations are done for you 
automatically.  You can also select a range of parameters to generate your reports 
and compare results. 

Unlike elements of the paper-based version, Dare to Ask? Online does not give 
qualitative feedback.  Therefore, you may wish to supplement it with other resources, 
use some of the open-ended questions in the paper-based version or run focus 
groups.

All questionnaires are completed anonymously in the online version so you may not 
be able to identify individuals for support.  

You will need Internet access and for the best results each student must complete 
the questionnaire(s) individually.  However this is a very quick process and could be 
easily fitted into a short slot such as tutor time.  Even if different students complete 
the questionnaire at different times, the results can still be aggregated to give an 
overall picture. 
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Getting started 
The evaluation questionnaires do not ‘test’ individual students, they gather students’ 
perceptions on how well they have learnt various topics. They are grouped into 
commonly taught topics and you can choose to use as few or as many as you like. 
The maximum number of questions on any questionnaire is fourteen. 

Technical issues 
The questionnaires and reports are accessed via the Internet and should be 
straightforward to use.  If you experience problems, please check firstly with your 
own ICT technicians that your Internet access is working properly.  If problems 
continue and you are certain that it is not an internal issue then please contact us in 
writing by post or email outlining your difficulties.  

Occasionally, cells in the report may not display correctly when copied into your 
Excel workbook.  If this happens, first check that they are set up correctly  by 
selecting the affected cells and choosing Cells from the Format menu.  Then choose 
the correct format from the menu. For example if the dates do not display properly, 
ensure that you choose the Date option. See also the key points on page seven. 

Choosing a questionnaire 
You may wish to give students a free choice of questionnaire, but it is more likely that 
you will want a consistent choice.  See the hard copy resource for further information 
about the questionnaires. 

Your students may be working at a stage lower or higher than their chronological age 
would suggest. You can use all of these materials flexibly to suit your students, with 
the sets of statements being only indicative of the key stage. For example, some 
college students may be working on areas that are related to the key stage 4 
outcomes. It is possible to choose the “wrong” key stage in relation to the year group; 
this is deliberate so that you can have flexibility.  
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Using Dare to Ask? Online with students 
Student instructions and password 

Give each student a copy of the student leaflet “How to use Dare to Ask? 
Online.” The instructions begin at the first screen with the password logon. 
The student website address is not given on the leaflet so that you can 
better control access.  It is:

https://www.cfbt.com/daretoask

The student password is oxon.  This is a generic password for all students 
in Oxfordshire to enable ease of access.   

If you want meaningful reports for your school or college you will need to 
ensure that they choose their own school or college from the drop down 
box. The option “None” is available for those who are not attending a local 
school or college. You may prefer to log on yourself and begin with the 
students at the second screen.

Explain that you want to find out their views on what they have learnt about 
careers and planning for the future. Reassure them that this is not a test and 
that it will only take a few moments. 

Key points – student screens: 
See also the leaflet “How to use Dare to Ask? Online.

Screen 1 – initial logon 

Ensure that students choose the correct school/college in the first screen or 
login yourself and move on to screen two. 

Screen 2 – choosing the questionnaire 

There are key stage 3 and key stage 4 questionnaires.  As the student selects 
their key stage they are given the appropriate list of questionnaires to choose 
from.

Ensure that students choose the questionnaire you want them to complete 
from the drop-down list or give them a completely free choice. Make a note of 
the questionnaires that are being completed. 

Screen 3 – completing the questionnaire 

Ensure that students select the correct gender and year group  

If year group and key stage do not match, a warning will be given but the 
student can still proceed. The key stage chosen determines the list of 
questionnaires, but reports are generated by year group. 

All questions must be answered before the questionnaire can be submitted. A 
warning will be given if there are gaps. 
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Screen 4 – results 

The results screen should appear immediately. If the student wishes to retain 
the information, they must either  

o print the page or

o select, copy and save the results into a Word document, giving it a 
file  name.   

Once they leave the screen the individual results are lost. 

Students can either “return to the list of questionnaires” if they wish to 
complete another one or “close”.  If they choose to “close” the website will 
close completely. If you have another student waiting, you should instruct 
them to return to the list of questionnaires. The next student can select a 
questionnaire, input their own details and continue.  As the questionnaires are 
anonymous, this will not adversely affect the results.  

You will find it helpful to keep a manual record of which questionnaires have 
been completed, when and by whom. An example of a suitable record is 
included in this pack.
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Students: How to use Dare to Ask?
Online.

Screen 1 – Log in with the password you have been given 

Screen 2 – Choose a questionnaire 

Screen 3 – Fill in the questionnaire 

Choose your school 
or college 

Enter the password

Click on “submit” 

Pick your “key 
stage”

Choose a 
questionnaire 

Click “submit” 

Choose from Male 
or Female

Choose your 
correct year group 

Answer each 
question



 Dare to Ask? Online 

User guide 

 6 

Screen 4 – Send the questionnaire 

Screen 4 – Read the results then print or save

When you have 
answered all of the 
questions,

click on “submit” 

If you want to print
your results or 
copy and save to a 
Word document, 
use the “drop down” 
options from “File”.
You must give the 
file a name as you 
save it. If you just 
close down instead, 
you will not be able 
to look at your 
results again later. 

EITHER

Close down the 
website if no-one 
else is waiting to 
use it. 

OR

Go back to the list 
of questionnaires. 
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Generating reports  - staff access only 
The reporting facility for Dare to Ask? Online is password protected.  Each school 
has a unique password that allows you to access your own reports according to 
various criteria. See also the leaflet “ Accessing your report” 

The data are centrally collected so that they may be aggregated to show trends 
across an area, for example across a 14-19 consortium or across Oxfordshire. 
Individual schools cannot access this data – please contact us for further information. 

WEBSITE IS https://www.cfbt.com/daretoask/reportLogin.aspx

Key points – staff screens 
Screen one – log in 

The staff instruction sheet takes you through the process step-by-step.  You 
will be given a password so that you can access your own institution’s reports  

Screen two – enter criteria 

For most selections you can hold down the CTRL key to select multiple 
options BUT you can only choose one questionnaire at a time. 

You can only choose by year group  - not by tutor group. 

By selecting the date range you can run a report that aggregates the results 
from a specific day or from a longer period. For example, you can select the 
day on which specific tutor groups completed the questionnaire and compare 
the results with a different day and tutor groups. You could run a report for 
2009 and compare it with 2008, BUT see notes for screen four below – you 
need to save or print as you go and the results will give you one total for your 
selected period. 

The results show the total responses according to the criteria you have 
chosen for a specific questionnaire. 

Screens three and five – view/download report or close down 
Before you see the results you must choose the view/generate report option.   
If you use the “Back” button from the report screen, you return to this view.  At 
this point you can set up a new report with different criteria or close down the 
website.

Screen four – view the results 
The Excel format report shows a summary of the choices you have made on 
screen two.  The results show the aggregated totals and percentages.  
The report is not stored on your system.  If you want to keep the report for 
comparison or to share with others, you MUST highlight and copy the cells 
you require, then open Excel on your machine and paste into a new 
workbook and/or print it using the normal commands from the “File” menu.   
Then save the new workbook, giving it your chosen file name so that you can 
identify it later.  For example Y9 SA1 01Jan08 or Y9 10 11 PO1 Feb08. 
You can then use normal Excel functions. You should separate out the 
numbers and percentages into new cells if you wish to draw a chart. 
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Staff instructions – accessing your 
report

WEBSITE IS https://www.cfbt.com/daretoask/reportLogin.aspx

Screen 1 – log in

Screen 2 – enter criteria for your report 

Choose your school 
or college from the 
drop down list 

Enter your 
password

Submit the form (do 
not just press the 
“enter” key) 

Choose the 
combination of 
gender,
questionnaire and 
year group that you 
require.

Carefully select the 
date range.  

Generate the report
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Screen 3 – view/download your report

Screen 4 – view the results 

Screen 5 – generate another report or close down 

Generate the report 
using the 
View/Download  
button

Select cells and 
copy - paste into 
your Excel 
workbook or print
from the File menu. 

Save and name
the file 

Use the Back button
to return to the 
previous menu 

Choose to 
generate a new 
report

Or choose to close 
the website 
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Questionnaire usage log 
Date Year group Tutor groups Questionnaire 

Reference
code

Report saved as (name) 
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Questionnaire usage log 
Date Year group Tutor groups Questionnaire 

Reference
code

Report saved as (name) 
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Contact details 

For information or further support

Careers Education Development 

Connexions Centre 

62 Stert St 

Abingdon

Oxon 

OX14 3UQ 

Anne Newton anewton@cfbt.com

or

Elaine Barnes ebarnes@cfbt.com

You may wish to note your school password here: 






